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ABSTRAKT 

KLAČKO, Jozef: OPNET - Simulácia siete ŽU [diplomová práca] – Ţilinská univerzita 

v Ţiline. Fakulta riadenia a informatiky, Katedra informačných sietí. – Vedúci: Ing. 

Ľudovít Mikuš, PhD. – Stupeň odbornej kvalifikácie: Inţinier v odbore Informačné 

systémy. Ţilina: FRI ŢU v Ţiline, 2010 – 56 strán. 

         Cieľom práce je vytvoriť model chrbticovej siete Ţilinskej univerzity v Ţiline 

v programe OPNET Modeler. Vo vytvorenom modeli simulovať prevádzku spôsobenú 

elektronickým vyučovaním a vyhodnotiť výsledky simulácií. Okrem uvedeného je 

v práci popísaný stav siete, spôsoby modelovania prevádzky v programe OPNET 

Modeler a spôsoby, ako zrýchliť simuláciu. Zároveň sú uvedené príklady na správanie 

sa siete pri zlyhaní linky, príklady nastavenia a pouţitia smerovacích protokolov 

a modelovanej prevádzky. Výsledky práce slúţia ako príprava na zavedenie 

elektronického vzdelávania formou e-kurzov a video prednášok. 

Kľúčové slová: OPNET Modeler, simulácia, sieť, elektronické vzdelávanie 

  



  

ABSTRACT 

KLAČKO, Jozef: OPNET – Simulation of UoZ network [diploma thesis] – The 

University of Ţilina. Faculty of Management Science and Informatics, Department of 

Information and Communication Networks. – Leader: Ing. Ľudovít Mikuš, PhD. – 

Degree of qualification: Engineer in field Information Systems. Ţilina: FRI ŢU v Ţiline, 

2010 – 56 pages. 

         The aim of diploma thesis is to create model of network backbone of University of 

Ţilina in OPNET Modeler. Then in created model simulate network transmission 

caused by e-learning and evaluate results of simulations. In addition is in this thesis 

described actual state of network, methods of modeling network traffic in OPNET 

Modeler and ways to speed up the simulation. There are examples of the behavior of 

network in case of line failure, examples of setting and using routing protocols and 

modeled network transmission. The results of the work are useful for preparation of 

implementation e-learning through e-courses and video lectures. 

Keywords: OPNET Modeler, simulation, network, e-learning 
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ÚVOD 

Vývoj technológií súvisiacich s prenosom údajov je sprevádzaný rýchlymi 

zmenami. Zmeny sa prejavujú v oblasti poskytovania sluţieb a následne aj v oblasti 

vývoja hardvéru a softvéru. Nový druh sluţieb, ale aj poţiadavky na zvyšovanie kvality 

v poskytovaní súčasných sluţieb spôsobujú neustály nárast poţiadaviek parametre siete. 

A to najmä na priepustnosť dosahovanú na ceste od servera ku klientovi. Tá je 

ovplyvnená aj šírkou pásma liniek a rýchlosťou spracovávania údajov v zariadeniach. 

Jednou z novších sluţieb poskytovaných po sieti je aj sluţba elektronického 

vzdelávania. Úlohou elektronického vzdelávania je efektívne vyučovanie z pohľadu 

študenta, ale aj vyučujúceho. Existuje viac spôsobov, ako vykonávať elektronické 

vzdelávanie. V práci som testoval dve moţnosti. Prednášky, ktoré by boli nahrávané 

a spracované do videozáznamu a vzdelávanie pomocou vytvorených e-kurzov, 

obsahujúcich text a krátke animácie. Obidva spôsoby vyučovania majú rozličné nároky 

na prvky siete, pričom prvá vyţaduje prenos väčších objemov dát prenášaných ako 

prúdový tok. 

Testovať uvedenú prevádzku na produkčných systémoch môţe byť nákladné, 

zdĺhavé a mať nepriaznivé dôsledky na ostatné poskytované sluţby siete. Preto je 

vhodné sieťovú prevádzku najprv simulovať a aţ  potom preniesť poznatky zo simulácií 

do praxe. 

Cieľom práce je overiť pripravenosť chrbticovej siete na prevádzku spôsobenú 

elektronickým vzdelávaním simuláciou v programe OPNET Modeler. 

 



   

 2  

POJEM A VÝZNAM E-VZDELÁVANIA 

„E-vzdelávanie je elektronické vzdelávanie, ktoré využíva počítačovú sieť na realizáciu,  

interakciu alebo podporu výučby. Počítačovou sieťou sa pritom rozumie lokálna sieť 

intranet alebo celosvetová sieť internet.“ [1] 

„Oproti iným formám má využitie internetu množstvo výhod. V prvom rade je to 

mimoriadne rýchla a efektívna forma komunikácie – poskytuje možnosť posielania 

textovej, obrazovej aj zvukovej formy informácie prakticky v reálnom čase a za veľmi 

nízku jednotkovú cenu. Vďaka tomu vytvára priestor pre využívanie rôznych foriem 

učebných materiálov – od textov a obrázkov, cez animácie a audiozáznamy, až po 

videozáznamy a multimediálne interaktívne aplikácie.“ [1] 

Na prenos dát prenosovým médiom je potrebná prenosová kapacita. Tá pôsobí 

ako limitujúci faktor pri implementácií e‒vzdelávania. Zníţená prenosová kapacita 

obmedzuje mnoţstvo dát prenesených médiom, a tak aj kvalitu prenášaného videa 

a zvuku. Uvedený problém je značný najmä na pomalých pripojeniach. Zároveň zníţená 

kvalita videa a zvuku zniţuje kvalitu vzdelávacích materiálov a vzdelávacieho procesu. 

Preto je pri implementácii e‒vzdelávania nutné uvaţovať nielen o dopadoch 

implementácie e‒vzdelávania na prenosové médium, ale aj o dopadoch kvality 

prenosového média na e‒vzdelávanie. 
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SIEŤ ŢILINSKEJ UNIVERZITY 

Účel zriadenia siete 

Siete Ţilinskej univerzity (UTC-Net) bola zriadená pre výskumné a študijné účely 

s ohľadom na zameranie jednotlivých pracovísk. Značným prínosom je rozvoj nových 

aplikácií a foriem vzdelávania, podpora správy a výskumu nových sluţieb.  

 

 

Obr. 0.1 Stav siete UTC-Net v roku 1998 

 

Súčasný stav siete 

Sieť pozostáva z prístupových LAN sietí fakúlt, internátov a ostatných pracovísk 

univerzity, prioritne tvorených štruktúrovanou kabeláţou, vzájomne prepojených 

prostredníctvom metropolitnej siete (MAN-ŢU) . 

„MAN-ŽU spája pomocou optických vlákien jednotlivé lokality univerzity 

a vytvára vysokorýchlostnú chrbticovú sieť využívajúcu technológiu prepínaného 

gigabitového ethernetu. Aktívne prvky MAN-ŽU sú rozdelené do dvoch základných 

skupín. Jednu skupinu tvoria chrbticové prepínače zabezpečujúce spojenie medzi 

jednotlivými lokalitami metropolitnej siete, druhú skupinu aktívnych prvkov tvoria 
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prepínače umožňujúce pripojenie lokálnych prístupových sietí a ich začlenenie 

do VLAN podľa logickej štruktúry nezávisle na fyzickej dislokácii. Smerovanie paketov 

v chrbticovej sieti je realizované prepínaním na tretej vrstve.“ [2]. Vyuţíva sa 

dynamický smerovací protokol OSPF. 

Lokality SvF, FRI, Rektorát, internáty Veľký Diel (VD), Univerzitná kniţnica a 

školské domovy Hliny sú prepojené rýchlosťou 1Gb čo tvorí chrbticu MAN. Pouţité sú 

prepínače Cisco rady 35xx. „Centrálny prepínač Catalyst 3550 umiestnený v 

Univerzitnej knižnici zabezpečuje pripojenie celého komplexu internátov na VD, v 

budúcnosti aj ďalších univerzitných objektov v tejto lokalite a súčasne plní funkciu 

redundantného smerovača v prípade výpadku v centrálneho smerovania internátov 

VD.“ [2] V Obr. 0.2 niţšie sú znázornené jednotlivé optické trasy MAN 

sprevádzkované do novembra 2007. Okrem toho sú optickými vláknami pripojené aj 

budovy NR, NS, nová menza. Prenosová rýchlosť na prípojkách týchto objektov je 

100Mbps. 

 

 

Obr. 0.2 Stav siete v roku 2007 

 

Pripojenie siete UTC-Net do Slovenskej akademickej sieti (SANET) a tým aj 

internetu je zabezpečené prostredníctvom pripojenia na prepínač Cisco Catalyst 6509. 
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V rámci siete SANET je tento prepínač pripojený na prepínač v Martine a Púchove 

a zároveň na prepínač v Poľsku do siete PIONEER. Priepustnosť všetkých liniek 

v oboch smeroch je 10Gb/s. Názornejšie to zobrazuje Obr. 0.3. 

 

 

Obr. 0.3 Slovenská akademická a dátová sieť. Pripojenie Catalyst 6509 na Martin, Púchov a sieť 

PIONEER 
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MODELOVANIE SIEŤOVEJ PREVÁDZKY V 

PROGRAME OPNET MODELER 

OPNET Modeler je simulačný balík, vyvíjaný spoločnosťou OPNET Technologies, Inc. 

Hlavným pouţitím je zrýchlenie procesu vývoja a výskumu sietí, zariadení, protokolov 

a aplikácií. Ďalej „možno porovnávať vplyv rôznych technológií, modelovať rôzne typy 

prevádzky (VoIP, TCP, OSPF, MPLS, IPv6, ...)“ [3]. Sieť je v OPNET Modeler 

simulovaná diskrétnym udalostným simulačným jadrom s podporou analytickej 

simulácie. 

OPNET Modeler umoţňuje modelovať sieťovú prevádzku rôznymi spôsobmi. 

Po vytvorení topológie siete je ďalším krokom pridanie prevádzky na sieti. Prevádzku 

do modelu moţno importovať z externých súborov (menu Traffic > Import Traffic), 

generovať alebo pridať ručne nastavovaním atribútov rôznych objektov. 

V OPNET Modeler sú dva druhy sieťovej prevádzky: Explicit a Background 

Traffic, prípadne prevádzka modelovaná ako kombinácia oboch druhov. 

Explicitná, diskrétna sieťová prevádzka (Explicit traffic) 

Explicitná prevádzka znamená, ţe je simulovaný kaţdý paket a naň nadväzujúce 

udalosti ako napr. vytvorenie paketu a čakanie paketu vo fronte, ku ktorým dochádza 

v priebehu simulácie. Explicitné modelovanie poskytuje presnejšie výsledky simulácií, 

pretoţe modeluje všetky vplyvy protokolov na model. Zároveň je doba trvania 

simulácie dlhšia. 

V OPNET Modeler existujú tri všeobecné metódy modelovania explicitnej 

prevádzky: 

 Simulovanie vytvárania paketov: Jednotlivým uzlom sú priradené zdroje – 

generátory všeobecných, podrobnejšie nešpecifikovaných paketov. Takéto 

pakety majú určené len niektoré parametre, napr. veľkosť paketu v bajtoch a 

interval medzi vyslaním paketu. Neobsahujú dáta z vyššej ako druhej vrstvy. Sú 

vhodne najmä na skúmanie technológií druhej vrstvy OSI (Ethernet, ATM, 

Frame Relay). Príkladom je objekt RPG (Raw Packet Generator) 

a IP_STATION z palety „Shared“. 
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 Modely prevádzky aplikácií (Application traffic models): Sú konfigurované 

v objekte Application Configuration z palety utilities (Obr. 0.7). Predstavujú 

najpouţívanejší spôsob modelovania sieťovej prevádzky. OPNET Modeler 

obsahuje vzorové nastavenia správania sa niektorých aplikácií, napríklad 

Database, Email, FTP, Print. 

 Modely poţiadaviek aplikácií (Application demands): Poţiadavky aplikácií 

sú pouţívané na modelovanie potenciálne premenlivých vzťahov medzi uzlami. 

Vtedy musia byť modelované ako výhradne explicitná prevádzka (Obr. 0.1 

a príklad v kapitole 1.1.1). Charakterizujú prevádzku len ako veľkosť a rýchlosť 

poţiadaviek a odpovedí (paketov) medzi dvomi uzlami. Výhodou je, ţe sa 

vytvárajú a konfigurujú jednoduchšie ako modely aplikácií prevádzky. Model 

poţiadaviek aplikácie je moţné konfigurovať ako výhradne explicitnú 

prevádzku, zmiešanú explicitnú prevádzku s prevádzkou na pozadí, alebo ako 

prevádzku na pozadí. Pomer druhov prevádzok je určený percentom v 

nastaveniach. 

 

 

Obr. 0.1 Určenie pomeru explicitnej prevádzky a prevádzky na pozadí v modeli poţiadaviek 

aplikácií 

 

Sieťová prevádzka modelovaná na pozadí liniek (Background traffic, 

analytical traffic) 

Tento druh prevádzky ovplyvňuje explicitnú prevádzku pridávaním variabilného 

oneskorenia, ktoré je spôsobené rôznymi dĺţkami vstupných a výstupných frontov. 

Na rozdiel od explicitnej prevádzky nie sú simulované jednotlivé pakety, a tak je 

podstatne zvýšená rýchlosť simulácie. Príklad grafu sieťovej prevádzky modelovanej na 

pozadí je uvedený v Obr. 0.18. 

V OPNET Modeler sú tri druhy takejto prevádzky: 

 Toky prevádzky (Traffic Flows): Predstavuje nastavenie toku dát modelov 

poţiadaviek aplikácií medzi dvomi uzlami siete cez určené medziľahlé uzly.  
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 Modely poţiadaviek aplikácií (Application Demands): Môţu predstavovať 

explicitnú prevádzku alebo prevádzku na pozadí. Podrobnejšie sú popísané 

v explicitnej prevádzke. 

 Základné zaťaţenie (Baseline Loads): Tento typ prevádzky predstavuje 

zaťaţenie linky alebo uzlu. Na rozdiel od prevádzkového toku (Traffic Flows) 

sa viaţe na jeden objekt, linku, ako základné vyťaţenie linky, alebo zariadenie, 

ako základné vyťaţenie CPU. 

 

Jednotlivé druhy explicitnej a prevádzky modelovanej na pozadí sú podrobnejšie 

popísané v nasledujúcej kapitole. 

Aplikácie (Applications) 

Modely aplikácie sú prevaţujúcim zdrojom prevádzky v modelovaných sieťach. 

Prevádzka generovaná aplikáciami zaťaţuje zariadenia a linky siete a vytvára 

poţiadavky na zariadenia. Pre optimálny výkon aplikácie musí byť infraštruktúra siete 

a serverov navrhnutá tak, aby spĺňali poţiadavky na pouţitie aplikácie. Na tento účel je 

potrebné najprv vytvoriť presný model aplikácie. 

Ak má byť reprezentácia aplikácie presná, model aplikácie by mal mať rovnaké 

vlastnosti v reálnej prevádzke ako aj v modelovanom príklade. Týka sa to veľkosti 

generovaných paketov, intenzity odosielania paketov, transportného protokolu pomocou 

ktorého sú pakety odosielané, počet súčasných aktívnych pripojení, nastavenie 

časovačov, opätovného prenesenia chybných paketov, správanie pri zlyhaní a obnovení 

a podobne. Spolu tieto vlastnosti vytvárajú vzor skutočnej prevádzky v modeli. Kaţdá 

aplikácia má jedinečný vzor prevádzky, alebo popis, a tak tvoria rôzne zaťaţenia siete 

a serverov. Cieľom modelovania aplikácie je  čo najvernejšie napodobniť správanie 

sa cielenej prevádzky. 

Pokiaľ ide o mieru podrobnosti alebo presnosti modelovania sieťovej prevádzky, 

existujú rôzne spôsoby modelovania. Jeden model môţe byť predstavovaný 

generátorom paketov, ktorý generuje udaný počet paketov za sekundu. Zloţitejší spôsob 

modelu prevádzky môţe byť predstavovaný detailným popisom výmeny správ medzi 

uzlami, vrátane logiky, podľa ktorej sa výmena a parametre správ riadia. OPNET 

Modeler poskytuje viacero spôsobov ako modelovať prevádzku, od jednoduchých po 

zloţitejšie. Všetky majú svoje výhody aj nevýhody, ktoré môţu výrazne ovplyvniť 
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správanie siete a rýchlosť simulácie. Preto je dôleţité pouţiť kombináciu vhodných 

modelov aplikácií. 

 

 

Obr. 0.2 Spôsoby modelovania prevádzky pomocou modelu aplikácií v OPNET Modeler [7] 

 

1.1.1 Model poţiadaviek prevádzky aplikácie (Application Demands) 

Modely poţiadaviek aplikácie vyţadujú minimálnu konfiguráciu. Je to 

najrýchlejší spôsob, ako v simulácii vytvoriť prevádzku aplikačnej vrstvy. Modely 

poţiadaviek predstavujú všeobecný model prevádzky typu klient – server. Klient 

posiela paket so ţiadosťou na server a ten na ţiadosť odpovedá. Ţiadosti a odpovede je 

moţné upraviť napr. zmenou veľkosti paketov alebo intenzity odosielania paketov. 

Tento typ modelu je vhodný ako doplnkový typ modelovania prevádzky 

pri súčasnom pouţití iných techník modelovania prevádzky. Zároveň je vhodný 

na skúmanie správania sa uzlov siete s rôznymi smerovacími protokolmi. 

 

Tab. 0.1 Výhody a nevýhody modelu poţiadaviek prevádzky 

Výhody Nevýhody 

Rýchle nastavenie prevádzky Prevádzka musí byť typu klient - server 

Môţu predstavovať explicitnú prevádzku 

alebo prevádzku na pozadí (viď kapitola 

0) 

Nepredstavujú špecifickú prevádzku (napr. 

FTP) 

 

Modely poţiadaviek prevádzky je moţné vytvoriť pouţitím menu „Traffic > 

Create Traffic Flows“ alebo z palety objektov „demands“. 

V prílohe A som vytvoril jednoduchý príklad. Je v ňom počítač (wkstn), ktorý 

posiela IP tok (paleta demands, ip_traffic_flow), ďalej len AD - Application Demand, 

veľkosti 1,6 Mb/s na server. 
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Obr. 0.3 Topológia siete z príkladu. Šípka predstavuje tok dát modelovaný pomocou AD 

 

Kvôli nastavenému zlyhaniu linky medzi smerovačom router1 a prepínačom switch, 

ku ktorému dôjde v čase 500 sekúnd od začiatku simulácie, je AD nastavený ako 100% 

explicitný typ prevádzky (Traffic Mix - Obr. 0.1). Ak by som ponechal, aby model 

poţiadavky prevádzky bol modelovaný ako prevádzka na pozadí, vo výsledkoch 

simulácie pôjde tok aj cez zlyhanú linku. Porovnanie oboch spôsobov modelovania AD 

je na Obr. 0.4 a Obr. 0.5. Simulácia je nastavená na 1000 sekúnd simulačného času. Pre 

porovnanie počet udalostí simulačného behu, kedy bol AD modelovaný ako 100%-ný 

explicitný typ je pribliţne 26 miliónov a trvala pribliţne dve minúty. Naproti tomu 

simulácia s AD modelovaným ako prevádzka na pozadí vykonala len 46 tisíc udalostí 

s trvaním menej ako dve sekundy. Príklad na modelovanie zlyhania linky je v kapitole 

1.1.12. 
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Obr. 0.4 AD modelovaný ako 100% explicitný, graf hore, tok dát na linke medzi switch1 a router1, 

dole medzi switch1 a router2 

 

 

Obr. 0.5 AD modelovaný ako 100%-ná prevádzka na pozadí, graf hore, tok dát na linke medzi 

switch1 a router1, dole medzi switch1 a router2, Modelovaný tok napriek očakávaniu nie je 

ovplyvnený výpadkom linky 

 

Štandardne je vytvorená prevádzka rozkladaná do viacerých tokov zariadeniami 

na rozkladanie záťaţe (router, prípadne load balancer). Prepnutím nastavenia toku 

„Flow Type“ na „Microflow“ moţno dosiahnuť, ţe prevádzka týmito zariadeniami nie 

je ovplyvnená. V príklade ţiadne zariadenie nepodporuje funkciu rozkladania záťaţe. 

1.1.2 Štandardné modely prevádzky 

Sú to vstavané modely prevádzky. Výhodou oproti AD je, ţe model presnejšie 

zodpovedá reálnemu stavu a oproti ACE sa jednoduchšie implementuje. Obsahuje 
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modely prevádzky databázových aplikácií, elektronickej pošty, FTP, http, tlačenia, 

vzdialeného prihlásenia, VoIP a videokonferencií. Kaţdý model prevádzky má 

špecifické nastavenia. Napríklad v aplikácií HTTP je moţné z pohľadu klienta 

modelovať veľkosti sťahovaných objektov, počet týchto objektov a interval medzi 

poţiadavkami. Štandardné modely prevádzky je vhodné pouţiť na modelovanie 

prevádzky typického pouţívateľa, na skúmanie doby odozvy. V dokumentácii OPNET 

Modeler je uvedený priklad „Tutorial: Small Internetworks“. 

Aplikácie sú pouţívané modulmi „Profile Definition“ z palety „utilities“, ktoré 

predstavujú správanie klienta. OPNET Modeler obsahuje 16 vstavaných nastavení 

aplikácií. Ich pouţitie predchádza nastavenie poloţky „Application Definitions“ na 

hodnotu „Default“, ako je to v Obr. 0.6. Na jednoduchšiu implementáciu nastavení slúţi 

menu „Protocols > Applications“. 

 

 

Obr. 0.6 Spôsob nastavenia vstavaných aplikácií 

 

  
Obr. 0.7 Dve podoby modulov konfigurácie aplikácií a modulu konfigurácie profilov 

 

Tab. 0.2 Výhody a nevýhody štandardných modelov prevádzky 

Výhody Nevýhody 

Rýchle vytvorenie modelu správania sa 

beţných sieťových aplikácií 

Nepredstavujú model napodobňujúci 

špecifické implementácie od rôznych 

výrobcov 
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Prednastavené konfigurácie, napr. 

prezeranie obrázkov 

Neposkytujú moţnosť modelovať 

aplikáciu vo viacerých vrstvách, ako 

napr. klient - web server – databázový 

server, ale len na úrovni dvoch vrstiev 

uzlov klient – server 

 

Obr. 0.8 a Obr. 0.9 zobrazujú príklad nastavenia modelu aplikácií. Vytvoril som 

aplikáciu s názvom „HTTP prenos 1kB stranky a 200kB suboru“. 

 

 

Obr. 0.8 Aplikácia "HTTP prenos 1kB stranky a 200kB suboru " 

 

 

Obr. 0.9 Nastavenie veľkosti stránky a súbeţne sťahovaného súboru 
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1.1.3 Vlastné modely prevádzky 

Umoţňujú podrobnejšie modelovať prevádzku ako štandardné modely 

prevádzky. Aplikácia je delená na úlohy a tie prípadne aţ na fázy (Obr. 0.11). Úlohy sú 

zastúpené objektom Tasks (Obr. 0.10) z palety utilities. OPNET Modeler obsahuje 

príklad Custom_Application_Examples s podrobnejším opisom nastavenia úloh. 

Tento spôsob modelovania prevádzky je vhodný pri modelovaní jednoduchšej 

logiky nadväznosti správ, ale aj ak aplikácia zahŕňa viac spolupracujúcich uzlov. 

 

 

Obr. 0.10 Modul Tasks z palety utilities 

 

 

Obr. 0.11 Fázy úlohy 

 

Tab. 0.3 Výhody a nevýhody vlastného modelu aplikácie 

Výhody Nevýhody 

Škálovateľný, presné modelovanie 

prevádzky 

Nutnosť nastaviť všetky podrobnosti 

aplikácie 

Podporuje viac klientov a serverov 

Podpora logiky nadväzností správ 

 

V nasledujúcich dvoch kapitolách 1.1.4 a 1.1.5 popisujem ďalšie dve moţnosti ako 

okrem pouţitia fáz úlohy modelovať sieťovú prevádzku. OPNET Modeler obsahuje 
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modul ACE, ktorý slúţi na modelovanie prevádzky na úrovni zasielania jednotlivých 

paketov, pričom poradie správ je určené pouţívateľom určenou logikou, alebo 

zachytenou komunikáciou reálnej sieťovej prevádzky. 

1.1.4 Modely prevádzky získané zachytením reálnej prevádzky 

Okrem nahradenia fáz v úlohách, prostredie ACE poskytuje aj iné pokročilejšie 

funkcie, napr. prognózu oneskorenia na linkách s rôznou priepustnosťou bez pouţitia 

diskrétnej simulácie. ACE Analyst je vhodný na vytvorenie presného modelu prevádzky 

z reálnej prevádzky, bez podrobného skúmania. 

 

Tab. 0.4 Výhody a nevýhody modelovania prevádzky pomocou zachytenej prevádzky 

Výhody Nevýhody 

Verne modeluje sieťovú prevádzku 

aplikácie 

Potreba licencie 

Jednoduchá konfigurácia Len na simulovanie existujúcej aplikácie 

 Model aplikácie je vţdy ten istý, hoci 

v reálnom prostredí sa parametre menia 

 

Modely prevádzky sú v module ACE Analyst vytvárané transformovaním 

zachytenej prevádzky siete. Na prácu s ACE Analyst je potrebná licencia a funkčný 

Wireshark. [8] Odporúčaná verzia je 0.98. Mne správne pracovala aj verzia 1.26. 

Na zachytenie prevádzky je potrebná kniţnica Pcap. Keďţe som pracoval v OS 

Windows, pouţil som implementáciu WinPcap, ktorá slúţi na zachytávanie paketov 

v pôvodnej forme obídením funkčnosti protokolov. Okrem toho podporuje filtrovanie 

a zber štatistík. WinPcap pozostáva z ovládača, ktorý rozširuje moţnosti OS a poskytuje 

priamy prístup k niţším sieťovým vrstvám. WinPcap ako API k sieťovej karte vyuţíva 

NDIS. [9] Okrem načítania prevádzky zachytenej s pouţitím Wireshark existuje aj 

moţnosť nainštalovať na počítače produkt ACE Capture Agent, ktorý ma podobnú 

funkciu. Navyše podporuje funkciu centrálnej správy nainštalovaných agentov. (Hlavné 

okno OPNET Modeler > File > Application Capture Manager). Na Obr. 0.12 je 

zobrazené ovládanie ACE Capture Manager s nastaveným jediným agentom, 

pripraveným na začatie zachytávania. Okrem ukladania prijatej prevádzky pre potreby 

ACE Analyst je ACE Capture Agent schopný priamo odosielať informácie o prevádzke 
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do ACE Live, ktoré slúţi na meranie odoziev transakcií. Pomáha identifikovať 

problémy s výkonom aplikácií v reálnom čase. 

Na nasledovnom Obr. 0.12 je v Application Capture Manager nastavený jeden 

agent. Stlačením tlačidla Start Caputre dôjde k monitorovaniu prevádzky na určenej 

sieťovej karte. Po ukončení zachytávania prevádzky je súbor s prevádzkou uloţený 

na vzdialenom počítači. Skopírovanie súboru na lokálny počítač je zabezpečené 

stlačením Download Files. O interpretáciu uloţeného binárneho súboru do ACE Analyst 

sa stará Wireshark. Pred transformovaním binárneho súboru je potrebné nastaviť 

v globálnej konfigurácii hodnotu atribútu ace_external_decoder_prog na cestu 

k Wireshark, napr. C:\Program Files\Wireshark\wireshark.exe a zároveň 

ace_use_external_decoder na hodnotu 1. 

 

 

Obr. 0.12 Application Capture Manager 

 

Implementovať zachytenú prevádzku do modelovanej siete je moţné manuálne 

nastavovaním parametrov zariadení, a objektov, alebo pomocou menu Protocols > 
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Applications > Deploy ACE Analyst Application on Existing Network > as Discrete 

Traffic. 

1.1.5 Modely prevádzky vytvorené nastavením správ (ACE Whiteboard) 

Predstavuje oproti modelu prevádzky získanej zachytením moţnosť vytvoriť si 

vlastný podrobný model prevádzky tvorený správami medzi účastníkmi komunikácie, 

ktorý môţe byť navyše ovládaný skriptom napísanom v programovacom jazyku Python. 

Pri tomto spôsobe vytvorenia modelu je navyše moţné určiť veľkosť a čas odosielaných 

správ, čas spracovania správy v uzle a vytvoriť bloky správ, ktoré duplikujú 

odoslanú a prijatú správu ako dvojicu správ. 

  

Tab. 0.5 Výhody a nevýhody modelovania prevádzky pomocou ACE Whiteboard 

Výhody Nevýhody 

Zloţitejšia logika nadväznosti správ 

pomocou skriptov v jazyku Python 

Vykonávanie modelu aplikácie 

obsahujúcej Python skript môţe spomaliť 

vykonávanie simulácie Moţnosť upraviť v ACE Whiteboard aj 

súbor z ACE Analyst 

 

V nasledovnom príklade uvádzam vytvorenie modelu prevádzky pomocou ACE 

Whiteboard. Prevádzka je modelovaná ako prenesenie určeného počtu súborov 

s veľkosťou generovanou náhodne ako číslo z rovnomerného rozdelenia, zo servera 

na klienta. V príklade sú vynechané správy otvorenia a ukončenia spojenia. 

Vytvoril som nový prázdny súbor typu ACE Whiteboard. S pomocou sprievodcu 

som pridal dve komunikačné strany s názvom Client a Server. Názvy sú dôleţité, lebo 

sú pouţívané v nastavení simulácie. Zobrazia sa dve pomenované vodorovné osi a jedna 

os s časom v sekundách. Pomocou menu Insert > Message som vytvoril sériu troch 

správ, ako v Obr. 0.13. Parametre správy sa nastavujú v Message Editor. Modrá správa 

s veľkosťou 1116 bajtov predstavuje úvodnú poţiadavku klienta na server. Veľkosť 

správy som určil pozorovaním poţiadaviek na stiahnutie súboru. Biele lomené čiary 

predstavujú dĺţku spracovania správy v uzle. Takisto aj pomenovanie správ je dôleţité 

pri vyuţívaní skriptov. V mojom príklade nie. Ďalšie dve správy predstavujú 

odosielanie súboru a potvrdenie prijatia súboru. Veľkosť oboch správ je 1000 bajtov. 
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Obr. 0.13 Grafické rozhranie ACE Whiteboard 

 

V ďalšom kroku som vytvoril a upravil skript, ktorý zabezpečí odosielanie 

určeného počtu súborov, ktoré budú predstavované správami. Po označení prvej zelenej 

šípky a vybratím voľby Add Logic Script at Start z menu pravého tlačidla sa zobrazí 

nový skript.  

Naprogramoval som jednoduchú logiku odosielania správ (Obr. 0.14). V cykle, 

ktorý sa opakuje určený počet krát sú vytvárané správy s náhodnou veľkosťou. Doba 

spracovania správy v uzle má konštantnú hodnotu 0,01 sekundy. Riadky s komentármi 

začínajú znakom #. Slovo action je vyhradené a zabezpečuje nadväznosť správ. Príkaz 

get_parameter slúţi na získanie hodnoty definovaného parametra. 
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Obr. 0.14 Skript logiky odosielania správ v Python 

 

Okrem tohto skriptu je nutné hlavičke (Scripting > Header Block) definovať 

pouţitú kniţnicu random s generátorom pseudonáhodných čísel príkazom import 

random. V inicializačnom bloku (Scripting > Initialization Block) načítať a ošetriť 

parametre (Obr. 0.15). 

 

 

Obr. 0.15 Inicializačný blok 
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V neposlednom rade je potrebné deklarovať parametre, ktoré budú odovzdávané 

cez nastavenie objektu Tasks (Scripting > Declare Parameters). Hodnoty parametrov sú 

v skripte načítané cez funkciu get_parameter(‘nazov deklarovaneho parametra’). 

 

 

Obr. 0.16 Deklarácia parametrov 

 

Podrobnosti k skriptom sú rozobrané v dokumentácií OPNET Modeler: Modules > 

Ace Analyst > ACE Scripts for Filtering, Analyzing, and Visualizing. Texty skriptov sú 

v prílohách E, F, G. Uvedený príklad ACE modelu je v súbore 

ace_whiteboard_model_prenosu_suborov.aed v prílohe DVD. 

Prostredie ACE umoţňuje vytvorený model voľbou Prediction z menu vyskúšať 

pomocou diskrétnej simulácie, alebo odhadnúť zdroje zmeny dĺţky odozvy v rôznych 

prostrediach pomocou nástroja QuickPredict. Na nastavenie ACE modelu uzlom v sieti 

v projekte je vhodné pouţiť objekty z palety Shared Objects Palettes > ACE a menu 

Protocols > Applications. Príklad k implementácii ACE modelu prevádzky v sieti je 

súčasťou praktickej časti diplomovej práce, v prílohe na DVD, súbor 

uniza_core.opcfa projektu siete a v scenári scenario 50min ACE Whiteboard, prípadne 

scenario 6MB subor ACE Capture. 
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Obr. 0.17 Nástroj QucikPredict 

 

Toky sieťovej prevádzky (Traffic flows, Background routed traffic) 

Toky sieťovej prevádzky, ďalej len TF. Predstavujú spojenie AD a základného 

zaťaţenia linky (baseline load). Na rozdiel od základného zaťaţenia, ktoré sa viaţe len 

na jeden objekt, TF prechádza sieťou od zdroja k cieľu cez linky a uzly, ktoré 

ovplyvňuje.  TF môţe mať pomocou objektu path z palety definovanú presnú cestu. 

Uvedená moţnosť má význam napr. pri MPLS. 

Základné zaťaţenie (Baseline Loads) 

Predstavuje záťaţ, ktorá je aplikovaná len na jeden objekt – linku, 

alebo zariadenie. Základné zaťaţenie aplikované na linku nemá v diskrétnej simulácií 

vplyv na vyuţívanie systémových prostriedkov modelovaného zariadenia k linke 

pripojeného. 

Základné zaťaţenie linky sa nastavuje vo vlastnostiach linky Traffic Information, 

resp. v Traffic Center. Zaťaţenie CPU zariadenia vo vlastnostiach zariadenia > CPU > 

CPU Background Utilization. Na určenie zaťaţenia linky, alebo CPU sú pouţívané 

vlastné, prípadne štandardne vytvorené profily, ktoré predstavujú časový priebeh 

vyťaţenia. 

Modelovanie prevádzky pomocou základného zaťaţenia môţe zrýchliť simuláciu. 
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Obr. 0.18 Modelovanie priebehu zaťaţenia linky pomocou modelu základného zaťaţenia 

 

Najvyššiu, alebo priemernú záťaţ liniek v čase, počas ktorého záťaţe trvajú je 

moţné zobraziť v topológii pomocou menu View > Visualize Link Usage > Color by 

Link Usage > Baseline Link Utilization. 

 

 

Obr. 0.19 Zobrazenie základného zaťaţenia liniek v aktuálnom čase 

 

Rôzne farby predstavujú rôzne percentuálne vyťaţenie liniek v oboch smeroch, 

hrúbka čiar objem dát prenesených za sekundu. Čas, v ktorom je vyťaţenie zobrazované 

je moţné meniť nástrojom „Time Controller“ (View > Show Time Controller). 
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Obr. 0.20 Nástroj Time Controller 

 

Ak sú v profiloch priebehu zaťaţenia linky alebo modeloch poţiadaviek 

aplikácií (Obr. 0.18) a v simulácií (Time Controller) nastavené dátumy a časy spustenia 

profilov a tie majú byť spustené v rovnakom čase ako začiatok simulácie je dôleţité, 

aby bol rovnaký čas nastavený aj v nástroji Time Controller (View > Show Time 

Controller > Configure > Start modeling at time). 

Na správu prevádzky modelovanej na pozadí slúţi „Traffic Center“ (Traffic > 

Open Traffic Center). 
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METÓDY ZRÝCHLENIA SIMULÁCIE 

Nie vţdy je simulačný beh vykonaný dostatočne rýchlo. Rýchlosť simulácie je 

ovplyvnená rýchlosťou hardvéru. Vykonaním uvádzaných opatrení sa mi podarilo 

zrýchliť simuláciu. 

Paralelná simulácia 

Pod pojmom paralelná simulácia uvádzam koncept vykonávania simulačného behu 

na viacerých procesoroch, resp. procesorových jadrách súčasne, pričom výsledky 

simulácie sú rovnaké ako pri vykonávaní na jednom jadre. Výhodou oproti 

sekvenčnému vykonávaniu je zvýšenie rýchlosti simulácie. Pre paralelné vykonávanie 

simulácie je nutná podpora simulačného jadra a kód optimalizovaný pre vykonávanie 

paralelnej simulácie. Príkladmi, kedy paralelná simulácia profituje z paralelizmu sú 

udalosti, pri ktorých doba výpočtu je vyššia a udalosti, ktoré sa vykonávajú v iných 

častiach siete a navzájom sa neovplyvňujú. 

Nastavenie výhľadu [4], resp. okna (mnoţstva udalostí, ktoré sa môţu vykonávať 

samostatne) a iných poloţiek je moţné v nastavení simulačného behu Execution >  

Advanced > Kernel Preferences. Na sledovanie zmeny rýchlosti paralelnej simulácie 

oproti sekvenčnej je nutné zapnúť Potential execution speedup (Execution >  Advanced 

> Kernel Reports) a sekvenčné vývojové simulačné jadro. Dôjde k vygenerovaniu 

tabuľky zobrazujúcej odhad zrýchlenia paralelnej simulácie oproti sekvenčnej. Po 

vykonaní sekvenčnej simulácie je moţné zmeniť typ simulačného jadra na paralelné 

a porovnať rýchlosti. 

 

Distribuovaná simulácia 

OPNET Modeler dokáţe vyuţiť viac jadier procesora nielen na paralelnú 

simuláciu popísanú vyššie, ale aj na vykonanie viacero simulačných behov s rôznymi 

parametrami v rovnakom časovom okamihu na viacerých počítačoch. Distribuovaná 

simulácia môţe byť pouţitá aj na spustenie simulácie na výkonnejšom vzdialenom 

počítači.  

Keď sa vykonáva distribuovaná simulácia, OPNET Modeler spusti určené 

mnoţstvo simulácií na kaţdom uvedenom počítači. Po skončení simulácie na procesore 

je vyuţitý na simulovanie ďalšej simulácie, pokiaľ nie sú všetky simulácie ukončené.  
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Priebeh jednotlivých simulácií je zobrazovaný v okne DES Execution Manager 

podobne, tak ako v Obr. 0.1. 

 

 

Obr. 0.1 Priebeh jednotlivých simulácií 

 

Na vykonanie distribuovanej simulácie je nutné splniť niektoré predpoklady: 

 Je nutné, aby model, resp. projekt bol umiestnený v tom istom zdieľanom 

sieťovom priečinku. Vhodné je priečinok pripojiť ako sieťový disk s úplnými 

právami na prístup a zapisovanie.  Tento priečinok musí byť rovnako nastavený 

v mod_dirs vo všetkých počítačoch. 

 Ostatné priečinky v nastavení mod_dirs môţu mať rôzne umiestnenie.  

 Výsledky sú ukladané do zdieľaného sieťového priečinku. 

 Kaţdému vyuţívanému procesoru zodpovedá platná licencia. 

Uvádzam príklad nastavenia. V nasledovnom príklade distribuovanej simulácie 

je nastavené jednoduché prostredie typu klient-server. Budem spúšťať simuláciu 

s rôznym počtom klientov aplikácie 10-krát. Pouţité sú predvolené aplikácie a profily. 

Distribuovanú simuláciu som pustil na dvoch počítačoch s OS Windows XP. 

Počítač s IP adresou 192.168.1.16 (localhost) v Obr. 0.2 obsahuje dvojjadrový procesor. 

Počítač slúţi na normálnu prácu a vytváranie modelov.  
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PCB: jedno jadro

 192.168.1.14

PCA: dve jadrá

192.168.1.16

C:\distributed_projects\

OPNET Modeler 

GUI

\\192.168.1.14\

distributed_projects Pripojenie na 

sieťový disk Y:\

Pripojenie na 

sieťový disk Y:\

Fyzická linka

op_des_server

 

Obr. 0.2 Topológia siete s distribuovanou simuláciou 

 

Na tomto som vytvoril zdieľaný priečinok C:\distributed_projects\, do 

ktorého som uloţil model test1_distributed. Priečinok má nastavené zdieľanie a 

prístupové práva je to zobrazené v Obr. 0.3, Obr. 0.4 a Obr. 0.5. Tento priečinok som 

na oboch počítačoch pripojil ako sieťový disk Y:\ príkazom: 

net use Y: \\192.168.1.16\distributed_projects /persistent:YES 
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Obr. 0.3 Nastavenie zdieľania prístupu k priečinku 

 

 

 

Obr. 0.4 Pridelenie prístupových práv k priečinku 

pre všetkých pouţívateľov 

 

Obr. 0.5 Nastavenie dodatočných práv pre 

všetkých pouţívateľov 
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Súbor test1_distributed.opcf s projektom sa nachádza v DVD prílohe. Je zabalený. 

Postup rozbalenia je nasledovný. V menu File > Manage Model Files > Expand Project 

File Archive do C:\distributed_projects\, resp. Y:\ a otvoríme v PCA z disku Y:\. 

Na oboch počítačoch som zmenil poloţku mod_dirs a pridal som na druhé miesto 

priečinok Y:\. 

V počítači PCA som zmenil hodnoty parametrov Allow Simulation Runs on 

Multiple Hosts na TRUE a do hodnoty atribútu Distributed Simulation Hosts som pridal 

dve poloţky localhost:7007:2, 192.168.1.14:7007:1. Parametre predstavujú adresu 

počítača, port a počet pouţitých procesorov na simulácie. 

Druhý počítač PCB s IP adresou 192.168.1.14  má procesor s jedným jadrom. 

Výkon jednotlivých jadier je porovnateľný. Na ňom je spustený príkazový riadok 

OPNET Console a simulačný server op_des_server.exe. 

Na oboch počítačoch je nainštalovaný samostatne pouţiteľný OPNET Modeler. 

V projekte otvorenom na počítači PCA som zmenil atribút klienta Applications > 

Application: Supported Profiles > Engineer > Number of Clients na promoted. To mi  

umoţní meniť počet klientov pri kaţdej  simulácii. 

V nastavení simulácie (DES > Configure/Run Discrete Event Simulation) 

nastavíme vstupy pre jednotlivé simulačné behy a to v menu Inputs > Object Attributes 

pridaním atribútu Office Network.klienti.Application: Supported Profiles [0].Number of 

Clients a zadaním viacerých hodnôt počtu klientov od 1 aţ po 10 s krokom 1 (Obr. 0.6).  

Počet simulačných behov sa zmenil z jedného na desať, ako v Obr. 0.6. Tie budú 

postupne rozkladané na jednotlivé procesory v počítačoch. V Obr. 0.7 je zobrazená 

závislosť počtu aktívnych pripojení od počtu pripojených klientov pre jednotlivé 

simulačné behy s rôznym počtom klientov. 
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Obr. 0.6 Nastavenie parametrov simulácie 

 

 

Obr. 0.7 Výsledky simulácie. Počet aktívnych pripojení (os y) protokolu TCP v závislosti od času 

(os x) a počtu počítačov v sieti (farebne odlíšené grafy) 

 

Pouţitie 64-bitového simulačného jadra 

Vyuţitím väčšieho adresného priestoru je moţné zrýchliť sekvenčné aj paralelné 

vykonávanie simulácie. Pri pouţití 64-bitového simulačného jadra OPNET je potrebné 

zváţiť rozdiely v implementácii jeho interných dátových typov na OS Windows 

a Linux. Pri pouţívaní 64-bitového simulačného jadra je nutné mať 64-bitový OS, 
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kompilátory a v neposlednom rade aj podporujúci hardvér. Zapnúť 64-bitovú simuláciu 

je moţné trvalo v nastaveniach, zmenením poloţky Compilation Flags for 64-Bit Code 

na hodnotu /GS- /Wp64. Systém potom automaticky vyberá medzi 32-bitovým a 64-

bitovým jadrom. Vynútenie pouţitia 64-bitového jadra je moţné nastavením poloţky 

Kernel Type. Viď nasledujúci obrázok (Obr. 0.8). 

 

 

Obr. 0.8 Príklad zapnutia 64-bitovej a zároveň paralelnej simulácie spustenej v dvoch vláknach 

 

Ak jednotlivé moduly neboli kompilované do 64-bitového adresného priestoru, 

dôjde ku kompilácii zdrojových kódov jednotlivých modulov. Dôvodom je, ţe tieto 

moduly sú štandardne kompilované len ako 32-bitové a sekvenčné. Kompilovanie 

modulov je moţné zmeniť hodnotou jednotlivých poloţiek v globálnej konfigurácii > 

Discrete Event Simulation > Code Generation > Compilation > ... Compile for 32-Bit, 

Development, Parallel Kernel; Compile for 32-Bit, Development, Parallel Kernel; 

Compile for 32-Bit, Development, Parallel Kernel; Compile for 32-Bit, Development, 

Parallel Kernel; Compile for 64-Bit, Development, Parallel Kernel; Compile for 64-Bit, 

Development, Sequential Kernel; Compile for 64-Bit, Development, Sequential Kernel; 

Compile for 64-Bit, Optimized, Sequential Kernel na TRUE. 

Pri vytváraní modulov môţeme nastaviť parametre kompilácie aj zmenou v menu 

Compile > Compile Code Advanced (Obr. 0.9). 
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Obr. 0.9 Parametre kompilácie modulu 

 

Zmena zobrazovania elementov výstupu počas simulácie 

OPNET Modeler počas simulácie priebeţne informuje o aktuálnom stave 

simulácie. Príkladom môţe vypisovanie odhadovaného času a počtu spracovaných 

udalostí. Zobrazovanie priebeţných výsledkov spomaľuje simuláciu. Vypnutím ich 

zobrazovania alebo ukladania sa simulácia zrýchli. Niekedy výrazne, inokedy len veľmi 

málo. Poloţky, ktorých zobrazovanie spomaľuje simuláciu a ako ich vplyv moţno 

zmenšiť: 

 Interval aktualizácie priebehu simulácie - Configure/Run  Discrete Event 

Simulation > Common > Update Interval nastaviť na vyššiu hodnotu, napríklad 

10 miliónov. 

Ostatné nastavenia sú jednotne v Configure/Run  Discrete Event Simulation > 

Runtime displays a Other displays: 

 Vykresľovanie grafu vyuţitia pamäte - Graph total memory usage during 

simulation. 

 Vypisovanie štatistík pamäte. Nie je štandardne zapnuté - Show memory 

statistics panel. 
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 Zrušenie vypisovania rýchlosti spracovávania udalostí za sekundu – Graph event 

processing speed. 

 Zobrazenie parametrov príkazového riadku simulácie - Display parameters 

passed to each simulation run. 

 Zobrazenie štatistík počas behu simulácie, tzv. live statistics - Display live 

statistics panel. Takýto typ štatistík musí byť správne definovaný. 

 Vytvorenie zoznamu súborov pouţitých v simulácii - Generate list of component 

file dependencies. 

Efektívne simulovanie protokolov OSPF, ARP, BGP, EIGRP, IGMP, 

IGRP, ISIS, RIP a SWITCH (STP) 

V konvergovanej sieti tvorí prevádzka smerovacích protokolov a protokolov 

iných vrstiev, napr. protokolu STP len malú časť šírky pásma. Zapnutím efektívneho 

simulovania protokolov dôjde po určenom čase k vypnutiu ich aktualizácie, avšak 

smerovacie tabuľky ostanú zachované. Efektívne simulovanie je vhodné pouţívať len 

ak nie je pomocou modulu Failure recovery nastavené zlyhanie linky alebo zariadenia 

(Obr. 0.1). 

Nastavenie efektívneho simulovania je v menu Configure/Run DES > Inputs > 

Global Attributes > Simulation Efficiency. 

Druhou moţnosťou, ako zrýchliť simuláciu siete pouţitím efektívneho 

simulovania protokolov je vyuţiť exportované smerovacie tabuľky. Výhodou je, ţe 

kaţdá aplikácia (modul application) pre riadenie prevádzky alebo poţiadavky (demand) 

môţu byť smerované okamţite bez čakania konvergenciu siete a naplnenie smerovacích 

tabuliek. Zrýchlenie nastáva najmä pri väčších sieťach. Pri udalostnej simulácii na to 

slúţi nastavenie Configure/Run DES > Inputs > Global Attributes > IP > IP Routing 

Table Export/Import. Prvý krát som spustil simuláciu s nastavením Export. Smerovacie 

tabuľky boli zapísané do súboru nazovprojektu-scenario.ot v priečinku modelu. Druhý 

krát som spustil simuláciu s nastavením Import. Na začiatku simulácie sú smerovacie 

tabuľky načítané do jednotlivých simulovaných zariadení bez potreby opätovného 

simulovania konvergencie siete. Po zmene topológie simulácia pracovala správne, aţ po 

opätovnom exportovaní a importovaní smerovacích tabuliek. 
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Oba popísané postupy nie je vhodné pouţívať, ak sú predmetom skúmania 

smerovacie protokoly alebo je nastavené pomocou modulu Failure Recovery (Obr. 0.1) 

simulované zlyhanie, prípadne zotavenie linky alebo zariadenia. 

Vývojové (development) a optimalizované (optimized) simulačné jadro 

Vývojové jadro je určené na ladenie kódu (debugging). Prepnutím simulačného 

jadra na optimalizované dôjde ku kompilovaniu modulov. Vynechaním réţie potrebnej 

na ladenie spôsobí, ţe udalosti sú spracovávané rýchlejšie. Dosahované zrýchlenie bolo 

na úrovni 50% aţ 300%. 

Optimalizácia kódu 

Zrýchliť simuláciu je moţné aj optimalizáciou zdrojových kódov jednotlivých 

modulov. Tematika optimalizácie kódu a algoritmov je obsiahla a nie je účelom tejto 

práce vysvetľovať jej princípy. 

Ako príklad uvádzam pouţitie hešovacej tabuľky pri práci so záznamami 

smerovej tabuľky smerovača. 

Na účely optimalizácie algoritmov sú určené vypisované štatistiky popísané 

v kapitole 0. OPNET Modeler obsahuje aj profiler, podporný program na zobrazenie 

častí kódu, ktoré sú vykonávané pomaly. 

Pouţitie modelu poţiadaviek aplikácií (Demands) a modelu prevádzky 

na pozadí (Background traffic) 

Nahradenie explicitne modelovanej prevádzky modelom poţiadaviek aplikácií, 

prípadne modelom prevádzky na pozadí, zmenší počet vykonávaných udalostí a zároveň 

zrýchli vykonávanie simulácie. Podrobnejší popis zaoberajúci sa modelovaním sieťovej 

prevádzky je v kapitole 0. 

Vypnutie zaznamenávania a zobrazovania animácií 

Počas simulácie je moţné zobrazovať a zaznamenávať pohyb modelov zariadení 

v priestore a pohyb dátových jednotiek. Zaznamenávanie animácie pri priemerných 120 

tisíc spracovaných udalostí za sekundu výrazne nespomaľuje simuláciu, naproti tomu, 

hoci zobrazovanie  dokáţe pomôcť pri ladení modelu, niekoľkonásobne ho spomaľuje. 

Zaznamenávanie je implicitne vypnuté. 
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Vypnutie zaznamenávania a zobrazovania sa nachádza v menu DES > Record 

Packet Flow, Record Node Movement a v Congirugre/Run DES > Outputs > Global 

Animation > 2D  

Obsah zaznamenaného súboru je binárny a je moţné ho transformovať do 

textovej formy a späť pomocou programu op_cvanim. Binárna podoba je nazývaná 

animation history, textová animation script. Skonvertoval som jeden binárny súbor. 

Kompletný súbor je uloţený v prílohe dvd v súbore test1_distributed-scenario1-DES-

1.as. 

Z menu štart som otvoril som OPNET príkazový riadok. Pomocou príkazov pre zmenu 

asresára cd som zmenil aktuálny adresár na adresár modelu so súborom zaznamenanej 

animácie. Príkaz op_cvanim -reverse TRUE -m test1_distributed-scenario1-DES-1 

konvertoval animáciu. 

Na opätovnú konverziu textového súboru zaznamenanej animácie na binárny som 

zmenil hodnotu -reverse z TRUE na FALSE. 

 

Okrem uvedených princípov a postupov, ako zrýchliť simuláciu existuje aj 

SMART MAC model, ktorý poskytuje abstrakciu MAC a fyzickej vrstvy bezdrôtových 

zariadení. 
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ŠTATISTICKÉ SPRACOVANIE VÝSLEDKOV 

DISKRÉTNYCH UDALOSTNÝCH SIMULÁCIÍ 

Jeden simulačný beh na určenie výsledných hodnôt nestačí. Zle zvolená násada 

generátora pseudonáhodných čísel môţe spôsobiť značné odchýlky presnosti. Preto, ak 

som chcel určiť správnosť výsledkov, čiţe odhadu, s nejakou mierou pravdepodobnosti, 

určil som intervaly spoľahlivosti nameraných údajov. Intervaly spoľahlivosti som 

vypočítal pre kaţdú zmenu parametrov veľkosti prenášaného súboru, alebo veľkosti 

prevádzky generovanej pomocou modelov poţiadaviek aplikácií. Na výpočty intervalov 

spoľahlivosti som pouţil odporúčaných 30 simulácií s rôznymi násadami, pričom 

hodnoty ostatných parametrov ostali bez zmeny (Obr. 0.1). Viac simulačných behov 

s rovnakou topológiou a konfiguráciou siete mi zabezpečilo jedinečnosť štatistických 

výsledkov pre rôzne rozdelenia pravdepodobnosti a rôzne výsledky náhodných 

premenných. 

 

 

Obr. 0.1 Viac hodnôt násady spôsobí spustenie viacerých simulačných behov 

 

1.1.6 Výpočet intervalov spoľahlivosti 

V nasledovnom príklade ukáţem postup výpočtu intervalu spoľahlivosti 

maximálneho vyuţitia linky, ktorý som vyuţil v diplomovej práci. Pre vyskúšanie 

výpočtu intervalov spoľahlivosti je v DVD prílohe súbor uniza_core.opcfa. Ten si 

rozbalím (File > Manage Project Files > Extract Project Archive). Teraz sa v určenom 

priečinku nachádza projekt. Postup je ukázaný na scenári s názvom 50min DEMANDS 

658kbps video. V modeli sú nastavené poţiadavky aplikácií do kaţdej fakulty. Ich 

veľkosti sú vypočítané ako suma poţiadaviek študentov fakulty za hodinu. Popis 

výpočtu veľkosti tokov je v Tab. 0.1. 
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Aby som spustil viac simulačných behov, nastavil som viac hodnôt násad 

v nastavení simulačného behu (Configure/Run DES) ako v Obr. 0.1. Problematikou 

distribuovanej simulácie sa zaoberám v kapitole 0. Po vykonaní všetkých simulácií sú 

vo výsledkoch simulácie zozbierané štatistiky vyuţitia linky medzi prepínačmi ne112a 

a swi (utilization ) z projektu uniza_core v prílohe A. Porovnaním grafov 

zo simulačných behov s rôznymi násadami vznikol  nasledovný graf: 

 

 

Obr. 0.2 Graf vyuţitia linky ne112a  swi 

 

Interval spoľahlivosti som vypočítal v záloţke DES Parametric Studies (Results 

Browser). V rozbalenej poloţke utilization   som nastavil atribút „max value“ na os y 

(Set As Y-Series). Na osi y grafu sú maximálne hodnoty zaťaţenia linky v percentách 

pre jednotlivé simulačné behy na osi x. Hodnoty maximálneho vyťaţenia linky 

sú roztiahnuté po celej osi x, pretoţe v grafe sú štandardne zobrazované čísla 

experimentov.  
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Obr. 0.3 Maximálne hodnoty zaťaţenia linky 

 

Na zobrazenie intervalu spoľahlivosti sú potrebné také body grafu, ktoré majú 

spoločnú hodnotu na osi x. Na zobrazenie takéhoto grafu som nastavil na os x názov 

scenára (Pravým tlačidlom myši na X-Series > Use Scenario Name As X-Series). 

 

 

Obr. 0.4 Nastavenie osi x grafu 

Teraz majú body rovnakú hodnotu na osi x. Tlačidlom Show sa graf zobrazí 

v samostatnom okne, hodnoty vyťaţenia linky sú pribliţne 76% aţ 78,3%. Interval 

spoľahlivosti je moţné zobraziť v grafe, alebo vypísať ako hodnoty. Pre vypísanie 

hodnôt stačí kliknúť pravým tlačidlom myši na sivú časť grafu a zobraziť dáta grafu 

(Show Statistics Data). V riadkoch zobrazených odspodu sú zobrazené 80%-né aţ 99%-

né intervaly spoľahlivosti.  

Pre zobrazenie intervalu spoľahlivosti v grafe je moţné vykonať úpravou grafu 

(kliknutím pravého tlačidla myši na plochu grafu a vybratím poloţky Edit Graph 

Properties. V novom okne je poloţka Show confidence interval.  
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Obr. 0.5 Nastavenie grafu na zobrazenie intervalu spoľahlivosti 
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ANALÝZA E-VZDELÁVACÍCH KURZOV 

Pri analýze kurzov elektronického vzdelávania a mnoţstva prenesených dát som 

vychádzal z práce [1]. Na strane 64 je vypočítaná priemerná hodinová sieťová 

prevádzka spôsobená kurzami na Fakulte riadenia a informatiky. Tieto údaje mi slúţili 

a podklad určenie hodnôt prevádzky. 

Druhy prevádzky 

Cieľom diplomovej práce bolo modelovať správanie chrbticovej časti siete 

pri nasadení elektronických vzdelávacích kurzov. Tieto zastupujú vyhľadávaciu triedu, 

prípadne prúdovou triedou (streaming). Tá predpokladá sluţby toku v reálnom čase. 

Jednalo sa jednalo o dva druhy realizácie elektronického vzdelávania: 

 Krátke videá alebo vektorové animácie so sprievodným textom 

 Päťdesiatminútové videá 

1.1.7 Krátke videá alebo vektorové animácie so sprievodným textom 

Pri vytváraní simulačných modelov som vychádzal z predpokladu, ţe jeden kurz 

obsahuje pribliţne 60 animácií s veľkosťou 100kB aţ 2MB. 90% animácií je veľkosti 

maximálne 500kB. Podľa [1], strana 80. 

Veľkosť jedného súboru je modelovaná distribučnou funkciou trojuholníkového 

rozdelenia pravdepodobnosti s parametrami (100000,2000000), ktoré predstavujú 

minimálnu a maximálnu veľkosť súboru v bajtoch. V druhom prípade som veľkosť 

súboru modeloval vlastným empirickým rozdelením, ktoré viac zodpovedá realite. 

Empirické rozdelenie je moţné modelovať v OPNET Modeler pomocou PDF Editoru, 

ako je v Obr. 0.2. Pravdepodobnosti (os y) hodnôt na osi x kvôli názornému zobrazeniu 

nezodpovedajú skutočnosti a nie sú normalizované na hodnotu súčtu 1. Preto súčet 

pravdepodobností jednotlivých hodnôt ≠ 0. 

1.1.8 Päťdesiatminútové videá 

Druhá, zatiaľ nerealizovaná moţnosť vzdelávania, ktorú som simuloval 

predstavuje vzdelávanie pomocou prednášok pozostávajúcich zo súvislých nahraných 

videí prenášaných po sieti, podobne ako sluţba na stránke www.youtube.com. Obrázok 

zo stránky sluţby youtube.com je v prílohe I. Trvanie jedného videa je pribliţne 50 

minút. Súbor s videom je zo servera na klienta prenášaný ako unicast, protokolom 
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HTTP, ako Flash video. Veľkosť súborov 50 minútových videí som ako určil pomocou 

oficiálnej kalkulačky bitovej rýchlosti Flash videa [5] a porovnal s bitovou rýchlosťou 

desiatich videí dĺţky pribliţne 50 minút. Obrázok tejto kalkulačky je v prílohe B.  

 

 

Obr. 0.1 Hustota pravdepodobnosti trojuholníkového rozdelenia s parametrami min = 100000, max 

= 2000000 (os y – pravdepodobnosť hodnôt z osi x) 

 

 

Obr. 0.2 Nenormalizovaná hustota pravdepodobnosti veľkosti súboru (os x – hodnoty veľkosti 

súboru, os y – pravdepodobnosť) 
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Tab. 0.1 Priemerné veľkosti súborov 50 minútových videí 

Rozlíšenie 

videa 

[pixelov] 

Počet 

obrázkov 

za 

sekundu 

Zmena 

obsahu 

Video 

kódek 

Priemerná 

bitová 

rýchlosť 

videa 

[Kbps] 

Zvukový 

kódek 

Vzorkovacia 

frekvencia 

[kHz] Kanály 

Kvalita 

kódovani

a zvuku 

Sumárna 

priemerná 

bitová 

rýchlosť 

[Kbps] 

Odhad 

veľkosti 

súboru 

50 min. 

videa 

[MB] 

320 na 240 15 malá H.264 84 AAC 11025 Mono Stredná 100 36,62 

320 na 240 25 malá H.263 160 MP3 11025 Mono Stredná 178 65,19 

320 na 240 30 malá H.263 192 MP3 11025 Mono Stredná 210 76,9 

448 na 336 25 malá H.263 314 MP3 11025 Mono Stredná 332 121,58 

640 na 480 25 malá H.263 640 MP3 11025 Mono Stredná 658 240,97 

 

V simulácií sú na modelovanie veľkosti videí podobne ako v modeli 

so šesťdesiatimi animáciami pouţité hustoty pravdepodobnosti s trojuholníkovými 

rozdelením. Trojuholníkové rozdelenie som zvolil preto, ţe je z moţností, ktoré sa dali 

v tomto prípade v programe OPNET Modeler pouţiť na modelovanie veľkosti súborov 

najviac vhodné. Parametre minimum a maximum trojuholníkového rozdelenia 

sú vypočítané z odhadu veľkosti súboru 50 min. videa [MB] ± 5 MB a zaokrúhlené na 

celé MB nahor alebo nadol. Napríklad video s veľkosťou 36,62 MB bude v zastúpené 

trojuholníkovým rozdelením s parametrami 31000000 a 42000000. Výsledné veľkosti 

súborov s videom pouţitých v simulácií sú overené na základe priemernej veľkosti 

desiatich prednášok s dĺţkou v rozmedzí 48 aţ 53 minút. 

Výsledky pre obidve moţnosti zloţenia kurzov - šesťdesiat animácií, alebo jedno 

päťdesiatminútové video sú v kapitole 0.  

Odhad počtu aktívnych študentov za hodinu 

Počet aktívnych študentov za hodinu predstavuje počet študentov, ktorí v danej 

hodine vyuţívajú nejaký vzdelávací kurz. Výpočet počtu aktívnych študentov 

na Fakulte riadenia a informatiky za hodinu je určený z pribliţného počtu počítačových 

učební, desať a pribliţného počtu študentov v študijnom krúţku 20. Z pomeru počtu 

študentov FRI v dennej forme štúdia 1270 a počtu aktívnych študentov 200 som 

vypočítal percento aktívnych študentov za hodinu zo všetkých študentov. Je to pribliţne 

15%. Z uvedených čísel som odhadom určil pomer mnoţstva vytvorených kurzov voči 

FRI. Vyjadruje mieru vyuţívania elektronického vzdelávania. Vynásobením počtu 

študentov danej fakulty, pomerného mnoţstva elektronických kurzov a percenta 
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aktívnych študentov som dostal odhad počtu aktívnych študentov danej fakulty. 

Výsledky sú v Tab. 0.2. 

 

Tab. 0.2 Určenie počtu aktívnych študentov 

Fakulta 

Počet 

študentov v 

dennej forme 

štúdia 

Počet 

elektronických 

vzdelávacích 

kurzov 

Pomerné 

mnoţstvo 

vytvorených 

elektronických 

kurzov voči 

FRI 

Počet aktívnych 

študentov za 

hodinu 

Elektrotechnická 

fakulta 1583 [6] 157 0,8 199 

Fakulta prevádzky a 

ekonomiky dopravy a 

spojov 2316 317 0,7 255 

Fakulta prírodných 

vied 1074 91 0,6 101 

Fakulta riadenia a 

informatiky 1270 112 1 200 

Fakulta špeciálneho 

inţinierstva 921 112 0,6 87 

Stavebná fakulta 902 45 0,6 85 

Strojnícka fakulta 1175 76 0,7 130 

pomer aktívnych 

študentov v jednej 

hodine na celkový 

počet študentov 200 / 1270 ≈ 15% 
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POROVNANIE PRVKOV SIETE S MODELMI 

OPNET Modeler obsahuje rozsiahlu databázu modelov zariadení rôznych 

výrobcov. Niektoré, najmä novšie modely neobsahuje, preto som ich substituoval 

najlepším moţným variantom modelu. 

 

Tab. 0.1 Reprezentácia zariadení v simulovanej sieti 

Zariadenie v sieti UNIZA Reprezentácia v OPNET Modeler 

Cisco Catalyst Switch 3750 Cisco Catalyst Switch 3560 

Cisco Catalyst Switch 3550 Cisco Catalyst Switch 3560 

Cisco Catalyst Switch 6509 

Cisco Router 1720 

Cisco PIX 515E 

 

Redundancia liniek a zariadení 

Zlyhanie ktoréhokoľvek prepínača z modelovanej siete spôsobí výpadok spojenia 

aţ do opravy, resp. nahradenia prepínača. Takéto výpadky bývajú zväčša viachodinové. 

Jediná výnimka sa týka prepínačov ne112a a ne112e. V prípade výpadku ľubovoľného 

jedného z nich je personál schopný do polhodiny manuálne zmeniť konfigurácie 

a substituovať jeden prepínač druhým. 

Takisto ţiadna relevantná linka medzi fakultami nie je zálohovaná. V prípade 

výpadku dôjde vo väčšine prípadoch k prerušeniu spojenia na vzdialený uzol. Obnova 

spojenia je moţná aţ po oprave linky, ktorá na trase zlyhala. Zriadenie zálohovania 

trasy je do budúcna plánované. 

V OPNET Modeler je moţné simulovať výpadok, prípadne obnovenie linky 

pomocou objektu Failure Recovery z palety utilities. 
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Obr. 0.1 Modul zlyhanie a obnova linky alebo uzlu 

 

Vyuţitie objektu Failure Recovery je v kapitolách 1.1.1 a 1.1.12  

 

1.1.9 Moţnosti zálohovania predvolenej brány v OPNET Modeler 

Hot standby router protocol (HSRP),  proprietárny protokol, predstavuje 

mechanizmus IP prevádzky bez prerušenia na sieťach podprujúcich multicast, alebo 

broadcast, ako napríklad Ethernet sieť. Protokol chráni proti zlyhaniu najbliţšieho 

smerovača. Pouţíva sa na ochranu proti výpadku predvolenej brány. V sieti ŢU nie je 

pouţitý. Podpora HSRP sa nachádza v OPNET Modeler.  
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IMPLEMENTÁCIA CHRBTICOVEJ SIETE 

V PROGRAME OPNET MODELER 

Pri implementácii jednotlivých prvkov siete som musel abstrahovať od niektorých 

parametrov. Dôvodmi boli najmä veľká časová náročnosť konfigurácie, výpočtová 

zloţitosť a mnoţstvo získaných údajov. Problémom zrýchlenia simulačných behov sa 

zaoberám v kapitole 0. Nastavovanie siete je moţné zrýchliť importovaním topológie 

siete a konfigurácie jednotlivých prvkov importovaním z VNE servera. Je to samostatne 

beţiaca aplikácia, ktorá pomocou agentov zisťuje topológiu, toky a aktuálny stav 

zariadení siete. Pouţívaný softvér OPNET Modeler neobsahuje VNE server. Výhody 

pouţitia importovania sa prejavia pri importovaní veľkého počtu zariadení.  

V praktickej časti práce som jednotlivé prvky pridával a konfiguroval manuálne 

podľa dostupných informácií. 

V prvom kroku som pridal uzly a prepojil ich linkami. Chrbticová sieť je 

modelovaná šiestimi prepínačmi Cisco Catalyst Switch 3560 (uzly studenti_internaty, 

uk, fri, ne112a, ne112e, aa0a), prepínačom Cisco Catalyst Switch 6509 (uzol fsi), 

smerovačmi Cisco Router 1720 (uzly zsr_zilina a letisko_hricov) a zabezpečovacím 

systémom - firewall Cisco PIX 515E (uzol pix). 

Uzol predstavujúci server s uloţenými elektronickými výučbovými materiálmi má 

názov http_server. Podľa poţiadaviek vedúceho práce je nadimenzovaný tak, aby aj 

relatívne veľký objem poţiadaviek bol bez problémov spracovaný. Tento uzol je 

predstavovaný modelom skutočného servera z kniţnice objektov - IBM p690 Turbo so 

šestnástimi dvojjadrovými procesormi taktovanými na frekvenciu 1700MHz. 
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Obr. 0.1 Topológia siete Ţilinskej univerzity v programe OPNET Modeler. Nepouţívané zariadenia 

sú preškrtnuté červeným kríţikom. 

 

V ďalšom kroku nasledovalo pridanie uzlov, ktoré predstavujú jednotlivé 

fakulty, nastavenie jednotlivých uzlov IP adries (Protocols > IP > Addressing)  

a overenie dostupnosti medzi uzlami pomocou modelu poţiadaviek aplikácií (IP Ping). 

Smerovací protokol OSPF som nastavil podľa nastavení v sieti ŢU. Ocenenie 

kaţdého rozhrania, v súvislosti s vytvorením grafu s najkratšími cestami medzi uzlami, 

je vypočítavané automaticky podľa referenčnej šírky pásma nastavenej na 1000000000. 

Ostatné relevantné hodnoty časovačov sú v Tab. 0.1. 

 

Tab. 0.1 Hodnoty časovačov protokolu OSPF 

Hodnota Čas v sekundách 

Hello Interval 10 
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Router Dead Interval 40 

Transmission Delay 1 

Retransmission Interval 5 

 

Hoci je v sieti pouţité rozdelenie na oblasti (area), v modeli som ich pre malý 

počet uzlov nenastavoval. 

OPNET Modeler nemá úplnú podporu sietí VLAN. Neúplnou podporou myslím, 

ţe všetky porty medzi prepínačmi, ktoré majú zapnutú podporu VLAN, musia byť tzv. 

trunk. Nie je moţné nastaviť prechod tromi VLAN sieťami, ak sú tieto siete na troch 

rôznych linkách. Preto som kaţdému L3 prepínaču pridal fyzické porty, ktoré je moţné 

smerovať. Na nich sú nastavené IP adresy. Pre modelovanie funkcionality siete nebolo 

potrebné nastaviť IP podľa skutočného stavu. 

Na hromadné nastavenie smerovacieho protokolu na všetkých zariadeniach som 

pouţil poloţku Configure routing protocol v menu Protocols > IP > Routing a Protocols 

> OSPF.  

Jednotlivé siete fakúlt sú modelované ako skupina počítačov pripojených 

na prepínače. Počítače predstavujú počet aktívnych pouţívateľov v hodine na danej 

fakulte. Takýto model je v OPNET Modeler zastúpený objektom s názvom 

1000BaseX_LAN z palety LANs (Obr. 0.2). Kaţdá fakulta je pripojená do chrbticovej 

siete linkou s priepustnosťou 1000 Mbit za sekundu. Prevádzka typu broadcast 

predstavuje oproti ostatnej prevádzke na sieti veľmi malý objem. Preto nehrozí, ţe by 

umiestnenie viacerých počítačov do jednej broadcast domény výrazne ovplyvnilo 

výsledky simulácie. 

 

 

Obr. 0.2 Objekt 1000BaseX_LAN, v modeli predstavuje aktívne počítače na určenej fakulte 
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V druhom kroku som na linky pridal pomocou prevádzky modelovanej na pozadí 

(kapitlola 0 a 0) základnú prevádzku. Tá odráţa súčasný stav prevádzky medzi 

jednotlivými fakultami. 

 

 

Obr. 0.3 Graf vyťaţenia linky medzi smerovačom fsi a smerovačom v Púchove, os x – čas v 

hodinách, os y – milióny bitov za sekundu 

 

 

Obr. 0.4 Reprezentácia základnej (baseline) prevádzky z uzla Púchov do uzla fsi v programe 

OPNET Modeler, os x – čas v hodinách, os y – bity za sekundu 

 

Pouţité modely prevádzky a výsledky simulácií 

Toky dát zo servera k pouţívateľom som modeloval dvomi spôsobmi: 

 Nastavením parametrov v objektoch profily a aplikácie 

 Modelom poţiadaviek dát (Application demands) 
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1.1.10 Model prevádzky vytváraný profilmi a aplikáciami 

Simulácia s vyuţitím tohto spôsobu modelovania prevádzky je výrazne pomalšia 

a spotrebuje veľa fyzickej pamäte. Výhodou je, ţe poskytuje napr. oproti modelu 

poţiadaviek dát presnejšie výsledky. Projekt modelovania prevádzky vytváraný profilmi 

a aplikáciami je v prílohe na DVD. Je to súbor uniza_core.opcfs a scenáre s názvami 

scenario 60 animacii EVENTS, scenario 50 min EVENTS. 

1.1.10.1 Profily a aplikácie: Simulácia prenosu 50 minútových videí 

Ani po mnohých pokusoch sa mi nepodarilo simulovať ani len pár sekúnd 

prevádzky 50 minútových videí. Na všetky simulácie som pouţíval počítač 

s dvojjadrovým procesorom, fyzickou pamäťou 2,5 GB a celkovou virtuálnou pamäťou 

15 GB. Príčinou zlyhania simulácie bol nedostatok pamäte. Simulácia prenosu dát 

presahovala moţnosti hardvéru. Vykonať simuláciu by bolo moţné s výrazne niţšími 

modelovanými objemami dát. Zobrazenie chyby je v prílohe H. 

1.1.10.2 Profily a aplikácie: Simulácia prenosu krátkych animácií 

Z jednej hodiny, počas ktorej jeden študent prenesie 60 krátkych animácií som 

z dôvodu dĺţky trvania simulačného behu simuloval len jednu minútu. Medzery medzi 

poţiadavkami na stiahnutie animácie sú exponenciálne s parametrom 60 sekúnd. To 

znamená, ţe za jednu hodinu stiahne študent v priemere 60 animácií. Z dôvodu 

konvergencie siete je vo všetkých simuláciách uvedených v nasledovnom texte 

nastavený čas prvej poţiadavky študenta na animáciu v rozmedzí 300 aţ 400 sekúnd. 

V čase 460 sekúnd končí simulácia. Súbory s projektom sú v prílohe na DVD v súbore 

uniza_core.opcfa. 

Výsledok 90%-ného intervalu spoľahlivosti maximálneho času odozvy na jednu 

stránku, pozostávajúcu z dvoch objektov – html stránka a krátka animácia, z 30 

simulačných behov s rôznymi násadami pre pseudonáhodné generátory je <0,13; 0,2> 

sekundy. Hodnoty 90%-ného intervalu priemernej odozvy HTTP prevádzky sú 

v rozmedzí <0,04; 0,2> sekúnd. Priemerne teda 0,09 s. so smerodajnou odchýlkou 

0.0259. Najvyťaţenejšia linka, medzi http_server a prepínačom ne112a, cez ktorú idú 

všetky poţiadavky a odpovede z jednotlivých fakúlt mala hodnoty intervalu 

maximálneho zaťaţenia v rozmedzí <103; 145> Mbit za sekundu, čo predstavuje 10 aţ 

15 percentnú širku pásma. Takýto typ prevádzky by po sieti bez väčších problémov 

prešiel. 
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1.1.11 Model poţiadaviek dát (Application demands) 

Modelom poţiadaviek aplikácií sa mi podarilo modelovať oba spôsoby 

vyučovania - 50 minútové videá a tieţ krátke animácie. Simulovaná časť predstavuje 

jednu hodinu. Nasledujúce príklady sú v scenároch s názvami scenario 50min 

DEMANDS 100kbps video, scenario 50min DEMANDS 178kbps video, scenario 

50min DEMANDS 210kbps video, scenario 50min DEMANDS 332kbps video, 

scenario 50min DEMANDS 658kbps video, scenario 60 animacii DEMANDS. 

1.1.11.1 Model poţiadaviek dát: Simulácia prenosu 50 minútových videí 

Prenos videí pomocou tohto modelu bolo nutné simulovať ako tok dát s určitým 

objemom za časovú jednotku. V Tab. 0.1 sú v stĺpci uvedené priemerné  bitové rýchlosti 

potrebné na prenos jedného videa uvedeného typu. Celkový objem dát prichádzajúcich 

do fakultnej podsiete je násobkom počtu aktívnych študentov za hodinu. Simuláciu som 

spustil pre päť druhov videí s rôznou bitovou rýchlosťou. V tabuľke sú zobrazené 

hodnoty 90%-ného intervalu spoľahlivosti vyťaţenia linky medzi uzlom http_video 

a prepínačom ne112a. V ostatných uzloch je podstatne niţšia prevádzka, preto ich vo 

výsledkoch neuvádzam. 

 

Tab. 0.2 Intervaly spoľahlivosti priemerného vyťaţenia linky medzi ne112a a http_server 

Bitová rýchlosť videa 

[Kbps] 

90%-ný interval spoľahlivosti vytaţenia linky 

[Mbps] 

100 < 103,713; 104,642 > 

178 < 184,862; 186,539 > 

210 < 217,896; 219,862 > 

332 < 345,172; 348,234 > 

658 < 683,250; 689,372 > 
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Obr. 0.5 Priemerné vyťaţenie linky v bitoch za sekundu pre jednotlivé druhy videí 

1.1.11.2 Model poţiadaviek dát: Simulácia prenosu krátkych animácií 

Údaje o veľkosti toku, ktorý bude predstavovať sťahovanie animácií som určil 

z výsledkov simulácie, v ktorej som nastavil, aby 100 počítačov pripojených v sieti 

s jednoduchou topológiou sťahovalo súbory s veľkosťou animácií. Intervaly medzi 

sťahovaním jedného súboru jedným študentom sú z exponenciálneho rozdelenia 

s parametrom 60 (sekúnd). Pribliţná veľkosť toku na 100 vychádza 8 Mbit/s. Podľa 

veľkosti výsledného toku som proporcionálne, podľa počtu aktívnych študentov na 

fakultách nastavil veľkosti tokov modelov poţiadaviek dát zo servera http_server.  
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Obr. 0.6 Veľkosť toku medzi http_server a ne112a v bitoch za sekundu, os y - bity za sekundu, os - 

x čas v sekundách 

 

Výsledky pre určenie toku spôsobeného sťahovaním krátkych animácií na 100 

študentov je v DVD prílohe [A], súbor s projektom uniza_core, scenár s názvom 

scenario 60 animacii DEMANDS skusam. Scenár simulácie prenosu krátkych animácií 

pomocou modelu poţiadaviek dát má názov scenario 60 animacii DEMANDS. 

Z hľadiska vyťaţenia sieťových prvkov je výhodnejšie pouţiť vzdelávanie formou 

krátkych animácií v porovnaní s ľubovoľným typom 50 minútových videí. Avšak 

vytváranie videí sa zdá byť časovo menej náročné na spracovanie a pri pouţití 

vysielania typu multicast, je moţné výrazne zníţiť prevádzku v sieti. 

1.1.12 Modelovanie zlyhania linky 

V práci som okrem príkladu v kapitole 1.1.1, kde rozoberám postup simulácie 

zlyhania linky, simuloval aj zlyhanie linky na chrbticovej sieti ŢU. Pred spustením 

simulácií som vypol efektívne simulovanie protokolu OSPF (kap. 0) V tejto časti sa 

venujem dopadu zlyhania liniek medzi prepínačmi fsi, ne112a a ne112e, postupne 

v poradí: 

1. fsi – ne112a 

2. fsi – ne112e 

3. ne112a – ne112e 

V prvom prípade uvaţujem, ţe zariadenia sú prepojené priamo. Tento model 

zodpovedá realite. V praxi sa často pouţíva aj iný spôsob zapojenia. Preto som vytvoril 

model, v ktorom sú prepínače prepojené cez ďalšie dva prepínače. Príklady sú v prílohe 
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DVD, súbor s projektom uniza_core v scenároch s názvami: scenario OSPF spamatanie, 

scenario OSPF spamatanie plus medzilahle. 

 

 

Obr. 0.7 Topológia časti siete po pridaní prepínačov medzi zariadenia ne112a, ne112e a fsi 

 

Prevádzka je simulovaná objektmi 1000BaseX_LAN, podobne ako 

v predchádzajúcich modeloch fakulty a sú umiestnené na rovnakých pozíciách 

s rovnakým pripojením. Rozdiel je v tom, ţe v jednom objekte je naraz aktívny len 

jeden počítač. Prevádzka jedného počítača predstavuje 10 poţiadaviek za sekundu 

s veľkosťou 700 bajtov, na ktoré server http_video odpovedá paketmi veľkosti 1000 

bajtov. To predstavuje sumárnu prevádzku v 10000 bajtov za sekundu v smere 

ku fakulte a 7000 bajtov za sekundu v opačnom smere. 

Po konvergencií siete je v čase 300 sekúnd spustená prevádzka zo všetkých fakúlt. 

V čase 350 sekúnd dôjde k výpadku prvej linky. Následne je po 100 sekundách linka 

obnovená a o ďalších 100 sekúnd nastáva zlyhanie ďalšej linky v poradí  popísanom 

vyššie. 

1.1.12.1 Analýza výsledkov simulácií 

V prvom prípade, keď sú prepínače fsi, ne112a a ne112e prepojené priamo je 

v prípade zlyhania ktorejkoľvek linky medzi nimi prevádzka okamţite presmerovaná. 

Tento stav je dôsledkom toho, ţe v prepínačoch dôjde k okamţitému zablokovaniu 

rozhraní, ktoré sú pripojené na zlyhanú linku. Namiesto pouţitia zablokovaného portu je 

prevádzka presmerovaná iným výstupným portom a inou cestou cez ktorý je miesto 
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určenia prevádzky dostupné. Z tohto dôvodu a v tomto prípade výpadok spôsobí stratu 

len veľmi malého mnoţstva paketov. 

 

 

Obr. 0.8 Grafy vyťaţenia liniek medzi zariadeniami ne112a <- fsi, ne112e <- fsi, ne112a -> ne112e. 

Po výpadku linky fsi – ne112a (prvý graf) v čase 350 s. je celá prevádzka medzi uzlami fsi a ne112a 

presmerovaná cez uzol ne112e (druhý a tretí graf). 

 

V druhom prípade, vďaka tomu, ţe zariadenia nie sú prepojené priamo sa 

v prepínačoch informácia o prerušení linky zostaví aţ po uplynutí času 40 sekúnd, keď 

nedôjde k prijatiu štyroch hello paketov protokolu OSPF. Dovtedy prepínač posiela 

pakety aj po ceste, ktorá obsahuje zlyhanú linku.  

V simulácií zlyhá linka medzi pridanými prepínačmi v rovnakom poradí ako 

v príklade bez medziľahlých prepínačov. 

V čase 350 sekúnd dôjde k zlyhaniu linky medzi uzlom fsi a ne112a, tak ako to 

vidno na poslednom grafe. Touto linkou nie je moţné preniesť ţiadne dáta, aj keď 

z oboch menovaných uzlov sú vysielané pakety ţiadajúce o prenos, prípadne pakety 

predstavujúce samotný prenos.  

V čase 390 sekúnd dôjde k vypršaniu času  (Router Dead interval), počas 

ktorého medzi fsi a ne112a z dôvodu zlyhania linky nedochádza k prenosu Hello 

paketov smerovacieho protokolu OSPF, ktoré dokazujú, ţe linka aj zariadenia sú v 



   

 55  

poriadku. Po tomto čase je v prepínačoch dosiahnutý stav, ţe uvedená cesta nie je 

pouţiteľná. Preto je celá prevádzka z uzla sub_fsi smerujúca na http_server 

presmerovaná uzlom fsi, v smere na uzol ne112e. V rozmedzí 350 a 390 sekúnd nie je 

moţné prepraviť prevádzku z uzla sub_fsi do uzla http_server a naopak.  

V čase 450 dôjde k obnoveniu linky a k obnoveniu posielania Hello paketov. 

Posielanie údajov v sieti prebieha ako pred prvým zlyhaním. Nasledovné zlyhania majú 

veľmi podobný charakter priebehu, ako vyššie uvedené zlyhanie. Situáciu ozrejmuje 

Obr. 0.9. 

 

Obr. 0.9 Graf sieťovej prevádzky na vnútorných linkách medzi prepínačmi ne112a -> ne112e, 

ne112e -> fsi,  ne112a > fsi. Správanie prevádzky v obidvoch smeroch liniek je okrem veľkosti 

prevádzky totoţné. Os x – mnoţstvo bitov prenesených linkou za sekundu v smere 

 

 

Obr. 0.10 Graf vyťaţenia linky pri serveri http_video, v smere od servera. Prvý graf zobrazuje 

prenosovú rýchlosť, ak sú medzi prepínačmi pripojené ďalšie prepínače, a teda nedostanú 
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okamţitú informáciu o výpadku linky. Druhý graf zobrazuje priame pripojenie prepínačov. Os x - 

čas v sekundách, os y - mnoţstvo prenesených bitov za sekundu. 

 

V prílohe C a D uvádzam ďalšie dva mnou vytvorené príklady modelovania 

sieťovej prevádzky. 
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ZÁVER 

Prevádzkovatelia sietí pri uvaţovaní o poskytovaní nových sluţieb a rozširovaní 

infraštruktúry stoja pred voľbou, ako sa ochrániť pred stratami spôsobenými zníţenou 

kvalitou poskytovaných sluţieb. Jednou z moţností, ako predísť takejto situácii je 

simulovať správanie siete. Účelom zriadenia siete Ţilinskej univerzity nie je zvýšenie 

zisku, ale je integrálnou súčasťou vzdelávacieho procesu a administratívnej činnosti 

súvisiacej so vzdelávaním. Sieť sa postupne vyvíja a pribúdajú do nej aj nové sluţby. 

Simulácia sieťovej prevádzky spôsobenej elektronickým vzdelávaním 

v chrbticovej sieti v programe OPNET Modeler sa na prvý pohľad zdá ako jednoduchý 

problém. Prvky siete a ich konfigurácia je s narastajúcim počtom zloţitejšia. Pomerne 

veľký problém je aj určenie počtu prenesených údajov. 

V práci som preveril pripravenosť chrbticovej siete pri záťaţi spôsobenej 

elektronickým vzdelávaním, stručne som porovnal pouţité modely zariadení so 

skutočnosťou a testoval následky výpadku linky na spojenie. 

 



   

  

PRÍLOHY 

Príloha B: Kalkulačka bitovej rýchlosti 

 

 

Príloha E: Inicializačný blok ACE skriptu 

# kontrola hodnot pred spustenim prevadzky 
#  
# deklarovanie premennej velkost_suboru ako int 
velkost_suboru = 400000 
min_velkost_suboru = self.get_parameter('Min velkost suboru') 
max_velkost_suboru = self.get_parameter('Max velkost suboru') 
 
# nacitaj pocet suborov 
pocet_suborov = self.get_parameter ('Pocet suborov') 
 
# kontrola hodnot 
if min_velkost_suboru <= 0: 
 self.sim_message ('Hodnota atributu Min velkost suboru je mensia 
ako 0.', 'Ukoncujem ulohu!') 
 self.quit () 
 
if min_velkost_suboru > max_velkost_suboru: 
 self.sim_message ('Hodnota atributu Min velkost suboru musi byt 
mensia ako Max velkost suboru', 'Ukoncujem ulohu!') 
 self.quit ()  
  



   

  

if pocet_suborov <= 0: 
 self.sim_message ('Hodnota atributu Pocet suborov musi byt 
vacsia ako 0', 'Ukoncujem ulohu!') 
 self.quit () 

 

Príloha F: Hlavičkový blok ACE skriptu 

# import kniznice random 
import random 

 

Príloha G: Funkčný blok ACE skriptu 

# samotne vykonanie ulohy (TASK) 
# action je API 
 
# nacitaj velkost suboru 
min_velkost_suboru = self.get_parameter('Min velkost suboru') 
max_velkost_suboru = self.get_parameter('Max velkost suboru') 
 
# pocet suborov = vykonanych cyklov 
pocet_suborov = self.get_parameter ('Pocet suborov') 
 
# zretazenie akcii, aby isli rovno za sebou ... potomok = predok 
(nasledovnik, predchodca) 
aktualna_akcia = action 
 
# ... 
for x in range (pocet_suborov): 
 
 # nahodna velkost dalsieho suboru rovnomerne rozdelenie 
 velkost_suboru = random.randint (400000,10000000) 
 # vypis do konzoly 
    # self.sim_message ('velkost suboru :',str(velkost_suboru))  
  
 # vytvor novu spravu (v konverzacii), novy subor, odkial, kam, a 
predchodca aktualnej akcie 
 sprava_novy_subor = self.create_message (velkost_suboru, 
'Server', 'Client', aktualna_akcia) 
 
 # ako dlho trva spracovanie poziadavky na serveri 0.01 sekundy 
 sprava_novy_subor.tier_delay = 0.01 
 
 # vytvor spravu (ACK), predchodca tejto spravy bude novy_subor 
 sprava_novy_subor_ack = self.create_message (100, 'Client', 
'Server', sprava_novy_subor) 
  
 # nastav ACK ako aktualnu action 
 aktualna_akcia = sprava_novy_subor_ack 
 
# na konci odovzdaj riadenie 
aktualna_akcia.take_over_children = 1 

 



   

  

Príloha H: Chybové hlásenie simulácie 

 

 



   

  

Príloha I: Stránka sluţby youtube.com 

 


